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Dear Reader,

Thank you for choosing the AUTODESK FUSION 360 ALL IN ONE WORKBOOK. This book is 

part of the CADIN360° learning series, created to help engineers, students, and 

professionals master Fusion 360 through structured and practical exercises.

This book contains over 500 carefully crafted practice drawings, including:

• 200 2D Sketching Exercises

• 200 3D Modeling Exercises

• Comprehensive Assembly Models with 150+ Individual Part Drawings

We founded CADIN360 in 2016 with the goal of delivering practical, high-quality learning 

material for CAD software. More than 9 years later, we’re still committed to producing 

consistently exceptional books. With each of our titles, we’re working hard to set a new 

standard for the industry. From the paper we print on, to the authors we work with, our goal 

is to bring you the best books available.

I hope you see all that reflected in these pages. I’d be very interested to hear your comments 

and get your feedback on how we’re doing. Feel free to let me know what you think about 

this or any other CADIN360 book by sending me an email at cadin360@gmail.com

If you think you’ve found a technical error in this book, please visit  

https://cadin360.com/contact-us/. 

Customer feedback is critical to our efforts at CADIN360.

Best regards,

Sachidanand Jha

Founder & CEO, CADIN360

https://cadin360.com/
mailto:cadin360@gmail.com
https://cadin360.com/contact-us/
https://cadin360.com/contact-us/
https://cadin360.com/contact-us/
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This book is copyrighted and the CADIN360 reserves all rights.

No part of this publication may be reproduced, stored in a retrieval system or transmitted, 

transcribed, stored in retrieval system or translated into any language, in any form or by any 

means, electronic, mechanical, photocopying, recording, scanning or otherwise, without the 

prior written permission of the publisher & Author.

Limit of Liability/Disclaimer of Warranty:
The publisher and the author make no representations or warranties with respect to the 

accuracy or completeness of the contents of this work and specifically disclaim all 

warranties, including without limitation warranties of fitness for a particular purpose. No 

warranty may be created or extended by sales or promotional materials. The advice and 

strategies contained herein may not be suitable for every situation. This work is sold with 

the understanding that the publisher is not engaged in rendering legal, accounting, or other 

professional services. If professional assistance is required, the services of a competent 

professional person should be sought. Neither the publisher nor the author shall be liable 

for damages arising herefrom. The fact that an organization or Web site is referred to in this 

work as a citation and/or a potential source of further information does not mean that the 

author or the publisher endorses the information the organization or Web site may provide 

or recommendations it may make. Further, readers should be aware that Internet Web sites 

listed in this work may have changed or disappeared between when this work was written 

and when it is read. 

Examination Copies
Books received as examination copies in any form such as paperback and eBook are for 

review only and may not be made available for the use of the student. These files may not be 

transferred to any other party. Resale of examination copies is prohibited 

Electronic Files & Usage Rights:
The electronic file/eBook in any form of this book is licensed to the original user only and 

may not be shared, distributed, resale or transferred to any other party. To access files, the 

user must contact cadin360@gmail.com with valid proof of purchase. Unauthorized 

distribution of the files is a violation of copyright law.

Disclaimer:
All product names, logos, brands, and registered trademarks mentioned in this publication 

are the property of their respective owners and are used for identification purposes only.
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AUTODESK FUSION 360 ALL IN ONE WORKBOOK

❖ This book contains over 500 CAD practice exercises, organized as:

 1. 200 2D Sketching Exercises

       2. 200 3D Modeling Exercises

       3. Assembly Projects with 150+ Part Drawings

❖ This book is a practice workbook. It does not include step-by-step tutorials for creating 

2D drawing, 3D models and Assembly.

❖ SI units (millimeters) are used for all dimensions.

❖ Third Angle Projection is used throughout this book.

❖ This book is for AUTODESK FUSION 360 and also suitable for Other Feature-Based 

Modeling Software such as Inventor, Catia, SolidWorks, NX, Solid Edge, AutoCAD, PTC 

Creo etc.

❖ Designed for students, engineers, drafters, and designers looking for extensive CAD 

practice using Autodesk Fusion 360.

❖ The exercises cover a wide range of real-world modeling challenges—from simple 

sketches to complex assemblies—offering clear, concise, and structured drawing 

practice.

❖ Exercises are organized to gradually develop beginner to advanced-level design skills.

❖ Each exercise is self-contained, and can be completed independently.

❖ Assembly drawings follow industry standards to help improve visualization and multi-

part modeling skills.

❖ All dimensions are in mm. Assume missing dimensions logically.
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 HOW TO USE THIS BOOK

This book contains over 500 CAD practice exercises, designed for self-paced learning using 

Autodesk Fusion 360 or any feature-based modeling software.

• 2D Sketching Exercises: Start here if you're a beginner or learning how to use the sketch 

environment. 

• 3D Modeling Exercises: Follow after mastering sketching. Practice creating solid models 

using the provided dimensions.

• Assembly Drawings: Use after completing part models to understand multi-part 

assemblies, relationships, and constraints.

Tips for Best Use:

• Complete the exercises in order, or jump to any skill level you prefer.

• All dimensions are in millimeters.

• Where dimensions are missing, apply logic or practice estimation.

• This book is ideal for both students and professionals preparing for industry design work.

Note: 

 This book is available in multiple formats – Black & White, Standard Color, and 

Premium Color editions.

  Happy learning!
  – Team CADIN360
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• LEARN • • APPLY • • GROW •

DRAWING FACES FROM
SCRATCH IN FUSION 360:
A STEP-BY-STEP GUIDE



Introduction
Fusion 360, a powerful computer-aided design (CAD) software, offers a wide range of tools to
create detailed 3D models. One of the essential tasks in 3D modeling is creating a sketch on a
face, which serves as the foundation for more complex designs. In this blog post, we will guide
you through the step-by-step process of starting a sketch on a face in Fusion 360.

Setting Up the Sketch Environment
Before creating a sketch, it's essential to understand the basic concepts of Fusion 360's sketching
environment. Familiarize yourself with the different tools and settings that will be used throughout
this tutorial.

1. Launch Fusion 360: Open Fusion 360 on your computer and create a new part or open an
existing one.

2. Enter Sketch Mode: Click on the "Sketch" tab in the top navigation bar to enter the sketching
environment.

3. Select a Face: Click on the face where you want to create the sketch. You can also use the
"Select Face" tool (hotkey: F) to select the face.

Creating a New Sketch
Now that you have set up the sketch environment, it's time to create a new sketch on the selected
face.

Step 1: Create a New Sketch
1. Create a New Sketch: Click on the "Create Sketch" button in the "Sketch" tab.

2. Select the Face: Make sure the face you selected earlier is still highlighted.

3. Choose a Sketch Type: Fusion 360 offers two types of sketches: "2D Sketch" and "3D
Sketch." For this tutorial, we will use the "2D Sketch" option.

Step 2: Define the Sketch Plane
The sketch plane is the 2D plane where you will create your sketch. You can define the sketch
plane manually or let Fusion 360 automatically detect it.

1. Define the Sketch Plane: Click on the "Define Sketch Plane" button.



2. Select a Reference: Choose a reference point on the face to define the sketch plane.

Adding Entities to the Sketch
Now that you have created a new sketch, it's time to add entities to it.

Step 1: Add a Point
1. Create a Point: Click on the "Point" tool (hotkey: P) and click on the face to create a point.

2. Verify the Point: Make sure the point is created on the face and is not intersecting with any
other entities.

Step 2: Add a Line
1. Create a Line: Click on the "Line" tool (hotkey: L) and click on two points to create a line.

2. Verify the Line: Make sure the line is created on the face and is not intersecting with any
other entities.

Modifying the Sketch Entities
As you add more entities to the sketch, you may need to modify them to achieve the desired
result.

Step 1: Move an Entity
1. Select an Entity: Click on the entity you want to move.

2. Move the Entity: Click on the "Move" tool (hotkey: M) and drag the entity to its new location.

Step 2: Rotate an Entity
1. Select an Entity: Click on the entity you want to rotate.

2. Rotate the Entity: Click on the "Rotate" tool (hotkey: R) and drag the entity to its new
orientation.

Conclusion
Creating a sketch on a face in Fusion 360 is a fundamental skill that requires practice and 
patience. By following the steps outlined in this tutorial, you should now be able to create a sketch 
on a face and add entities to it. Remember to experiment with different tools and settings to



achieve the desired result.

FAQ

Q: What is the difference between a 2D sketch and a 3D sketch
in Fusion 360?
A: A 2D sketch is a 2D plane where you can create 2D entities, while a 3D sketch is a 3D space
where you can create 3D entities.

Q: How do I select a face in Fusion 360?
A: You can select a face by clicking on it or using the "Select Face" tool (hotkey: F).

Q: What is the purpose of defining a sketch plane in Fusion
360?
A: Defining a sketch plane sets the 2D plane where you will create your sketch.

Q: Can I modify a sketch entity after it's created?
A: Yes, you can modify a sketch entity by using the "Move," "Rotate," or "Scale" tools.

Q: How do I save a sketch in Fusion 360?
A: You can save a sketch by clicking on the "File" menu and selecting "Save As."

Q: Can I reuse a sketch in another part or assembly in Fusion
360?
A: Yes, you can reuse a sketch by copying and pasting it into another part or assembly.

Q: What is the difference between a sketch and a feature in
Fusion 360?
A: A sketch is a 2D or 3D plane where you create entities, while a feature is a 3D entity that is
created from a sketch.
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Get The Complete 

Practice Sample
You downloaded a single Exercise PDF

What you will receive
• A software-specific complete sample PDF

• Multiple real practice exercises (not a single file)

• Same quality as our professional training material

• Compatible with the latest software version

The complete practice sample for this software includes multiple 

exercises and is not available inside this PDF.. 

How to get the complete sample
Click the button below and enter a valid email address.

The complete sample PDF will be delivered automatically
after the form is submitted.

SEND THE COMPLETE SAMPLE TO MY EMAIL

http://link.cadin360.com/pdf-form/?utm_source=singleSamplePdf&utm_medium=pdf&utm_campaign=autodesk-fusion-360-exercise
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Are you a Student, Unemployed or Financially struggling ?
Get this special Bundle only for $19.99

Get the Complete Bundle for Only $27.99

Get the Complete Bundle for Only $27.99

Special Offer for Students & Learners

Special Offer for Only $19.99

Special Offer for Only $19.99

END OF SAMPLE

What’s Included in the
 FUSION 360 ALL IN ONE WORKBOOK?

✓ Books contains exercises of Sketching, 3D 
Modeling & Assembly.

✓ 500+ Practice Exercises with Dimensions
✓ Full Assembly STEP Files (.stp format) – 

Compatible with all major CAD software
✓ Get 200 3D Exercises in .f3d file format
✓ Get All Assembly Exercises in .STP file
✓ Instant Download Link - Sent to Your Email 

After Payment
✓ Lifetime Access to All Files

Get the Paperback book on Amazon

Get the Paperback book on Amazon

https://link.cadin360.com/r/gsIn-s
https://link.cadin360.com/r/gsIn-s
https://link.cadin360.com/r/zdO5Nv
https://link.cadin360.com/r/zdO5Nv
https://link.cadin360.com/r/LzqWo5
https://link.cadin360.com/r/LzqWo5
https://link.cadin360.com/r/LzqWo5


 Thank You for Learning with Us!

Thank you for choosing the AutoDesk Fusion 360 ALL IN ONE WORKBOOK. We hope this 
book helped you strengthen your Fusion 360 skills through hands-on practice and real-
world design challenges.
Your feedback means the world to us!
If you found this book helpful, please take a moment to leave a review on the Amazon 
where you purchased it. Your kind words not only motivate us but also help other learners 
discover our resources. Scan the QR.

 A good review goes a long way!

 Explore More CAD Practice Books
Looking to continue your learning journey?
We offer similar practice-based books for 
over 30 CAD software platforms, including:
• AutoCAD
• SolidWorks
• FreeCAD
• TinkerCAD
• TurboCAD
• Siemens NX
• CATIA
• Creo
• SketchUp and many more...
Visit our website  www.cadin360.com to browse the complete collection.

 Stay Connected
Have suggestions, feedback, or just want to say hello?
We’d love to hear from you!

 Email: cadin360@gmail.com
 Website: www.cadin360.com

 Keep Practicing. Keep Designing.
Whether you're a beginner or a pro, practice is the key to mastering any CAD software. 
We're honored to be a part of your journey.
Happy Designing!
– Team Cadin360

https://www.cadin360.com/
http://www.cadin360.com/
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FUSION 360 ASSEMBLY DRAWINGS

A U T O D E S K

                 FOR PRACTICE

ABOUT THE BOOK

❖ S.I Units 

❖ Predominantly used Third Angle Projection.

❖ This book provides Assembly practice drawings.

❖ This book is for FUSION 360 and Other Feature-Based Modeling Software such as 

Autodesk Inventor, Catia, SolidWorks, NX, Solid Edge, AutoCAD etc.

❖ It is intended to provide Drafters, Designers and Engineers with enough CAD 

Assembly exercises for practice on FUSION 360.

❖ It includes almost all types of exercises that are necessary to provide, clear, concise 

and systematic information required on industrial machine part drawings. 

❖ Third Angle Projection is intentionally used to familiarize Drafters, Designers and 

Engineers in Third Angle Projection to meet the expectation of world wide Engineering 

drawing print.

❖ Clear and well drafted drawing help easy understanding of the design.


